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 The purpose of this thesis is to create a framework that assists in the transfemoral 

prosthesis fitting process by calculating balance and symmetry to quantify patient 

comfort with an understanding of bipedal locomotion and human anatomy. Three 

different software applications were used to compare (1) the body position during gait 

cycle, (2) the natural and amputee anatomies, (3) the natural and prosthetic legs, and (4) 

the equilibrium and torque movements of the hip, knee, and ankle joints. Models were 

created in Maya for analysis in Solidworks and MEL code evaluation with MatLab. The 

MatLab code tested combinations of joint degrees and identified stability leg rotations. 

Additionally, the center of mass (COM) analysis demonstrated that the 3rd combination 

of materials for the prosthetic leg proved to be closest in COM position to the natural leg 

(COM NLratio = 0.6241) with a COM ratio = 0.5972. COM determination assists in 

establishing symmetry in the prosthesis and amputee relationship. The (COM) alteration 

contributors were established as the stump length, prosthesis weight, and body position 

and anatomy.
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CHAPTER 1 - INTRODUCTION 

Prosthesis and orthotics have proven capable of improving the quality of life and 

create a sense of normalcy for those that have malformed or missing limbs [1]. In the 

context of leg prosthesis, the use and production of prosthesis is greatly dependent on the 

comprehension of the complicated method of bipedal locomotion. Human gait evaluation 

has been a topic of discussion and analysis in the medical world over the years and has 

contributed to the advancement of developments in human aid. However, gait differs 

from person to person, and even within an individual’s own gait pattens over time. 

Traditionally, the prosthesis fitting process is not only dependent on the benchmark 

standards, but is also dependent on the patient comfort levels and the fitter’s observed 

gait to obtain the “perfect fit” [3-4]. These unique human qualities thus make the scripted 

benchmark process difficult to model to each patient without individualizing the process. 

The use and observance of balance and symmetry, in addition to the current fitting 

methods, could be used to assist in obtaining an ideal fit of the prosthesis and enhance the 

relationship between the prosthetic and the wearer. Quantifying balance and symmetry 

could reduce some of the guess work that is currently a part of modern prosthesis fitting 

methods and ease the process for not only the technicians, but also the patients. The 

quantification of balance and symmetry has a potential impact on the current fitting 

process, but it is vital to first comprehend and identify the relationship between the 

elements within bipedal anatomy and locomotion. As a result, this thesis will focus on the 

use and comprehension of the relationship between symmetry, balance, and gait to 

possibly improve the fitting process with the aid of the computational analysis of torque, 

equilibrium, and center of mass. 
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Motivation 

In modern day prosthesis clinics, the leg fitting process is a method that follows 

strict benchmark guidelines and is reliant on the fitter’s trained eye for additional 

adjustments. This method has been essential in the prosthesis environment over the years 

since the benchmark requirements regulate the process to ensure the “ideal” outcome. 

Given the physical differences among people, especially in their presented gait patterns, 

the strict, rigid benchmark guidelines constrict the ability to create an individualized and 

unique fit that varies from patient to patient. To compensate, the current method of fitting 

relies on the fitter’s experience to make the required adjustments accordingly to 

individualize the process [4]. The prosthetics assembler’s seasoned view is meant to 

gauge and assess the patient’s gait onsite and adjust accordingly. Depending on the 

fitter’s experience makes this process susceptible to fitting inconsistencies and patient 

discomfort.   

Patient comfort is deemed as the relationship between the wearer and the 

prosthetic and is also known as “the comfort to wear” [7]. The fit of a prosthetic is often 

compared to that of shoes, and like shoes, the comfort to wear could exist within the 

moment and may diminish over time as the item is continually worn. In transfemoral 

prosthetics, the interaction between the stump and the socket is the most vital to 

determine the patient’s comfort level. Patient comfort then represents how a patient feels 

while wearing their prosthetic, an unquantified assessment of the stump socket 

interaction.  

Current prosthesis analysis methods focus mainly on gait analysis and patterns, 

but none focus on the quantifying and achieving balance and symmetry when comparing 
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the right and left side of the body’s structure. The ability to obtain a numerical value for 

balance and symmetry will allow for a more appropriate comprehension of bipedal 

anatomy and locomotion. A comprehension that will positively influence the fitting 

process adjustments and potentially quantify the definition of patient comfort. 

Research Objectives 

The overall objective of this thesis research is to create a framework that assists in 

the transfemoral prosthesis fitting process by calculating balance and symmetry to help 

quantify patient comfort. This research will be conducted using established gait data, as 

well as information gained through modeling software applications. The objective will be 

accomplished with the following tasks: 

Task 1: Calculation for natural bipedal structure 

a) Identify center of mass calculations and ratio formulas for human body 

b) Identify the relationships between the hip, knee, and ankle joints during gait 

c) Quantify symmetry and balance using torque and equilibrium 

Task 2: Calculation for bipedal transfemoral amputee and prosthetic 

a) Compare center of mass variables to that of the natural bipedal structure 

b) Determine the symmetry and equilibrium using natural and prosthetic leg center 

mass measurements 

c) Determine relationship between material of prosthetic and its center of mass 

The main aim of these tasks is to determine the relationships between gait, balance, 

and symmetry with quantified data. To test the gait values of rotation for the leg 
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functions, Maya (an Autodesk 3D animation software) will be used to model human 

replicas of natural bipedal and transfemoral amputee structures. With this software, it will 

be possible to manipulate polygons to the ideal shape of a human, as well as create a walk 

cycle animation for analysis. In conjunction with Maya, Solidworks would be used to 

verify center of mass alterations throughout the gait cycle. Lastly, MatLab will provide 

the platform for calculations that will allow for the creation of an algorithm that can be 

adjusted in accordance to the presented patient. With these three software products 

working in conjunction with each other, the above two tasks can be accomplished.  

The first task focuses on gaining baseline data of the human body in anatomical 

positionings as well as during natural gait. This baseline data will focus on the legs and 

the correlated rotations and forces that contribute to equilibrium, balance, and symmetry. 

The second task focuses on using the data collected from Task 1 and comparing it the 

new collected information from the transfemoral amputee model. The baseline data from 

Task 1 will allow for a more in-depth comprehension of how the equilibrium, balance, 

and symmetry are altered with an amputation and how the prosthetic may be most 

effectively utilized to regain the most “normal” equilibrium measurements.  
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CHAPTER 2 – LITERATURE REVIEW 

Biomechanics 

 Biomechanics is known as the application of physics, such as Newton’s Laws of 

Motion, torque, equilibrium, and the center of gravity, to the living structures, like the 

human body [14]. The study of biomechanics is divided into two major forms of study, 

kinematics and kinetics. Kinematics is the motion of the body, such as speed and 

acceleration, while kinetics refers to the forces applied to the body [15]. 

Angular kinematics as applied to the human body is an important application and 

element of comprehension because this concept is rooted in the study of joint movements 

and center of gravity calculations. Torque is presented as the twisting force applied to the 

joint, where counterclockwise is deemed as positive and clockwise is negative for torque 

vectors. The formula is as demonstrated in Eq. 1: 

𝑻𝑻 = 𝑭𝑭 ∙ 𝒅𝒅⊥ 

where 𝒅𝒅⊥ = the moment arm vector which is the shortest perpendicular  

displacement between the force line of action and the axis of rotation 

          𝑭𝑭 = force applied vector 

In torque, the moment arm and force are equally important, for understanding the weight 

and role of each variable within the equation as applied to the body and can assist with 

maximizing human performance or creating precision in human movements. For 

example, to create more torque, the patient can increase the moment arm or increase the 

(1) 
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applied force. A good variable to measure muscle strength is torque since it is 

independent of the force’s point of application on the limb.  

 Moment of inertia is the resistance of the body to rotation about an axis and is 

defined with Eq. 2 as demonstrated below: 

𝐼𝐼𝐴𝐴 = �𝑚𝑚𝑟𝑟2 

 where 𝐼𝐼𝐴𝐴= moment of inertia about an axis 

  𝑚𝑚=mass of the object 

  𝑟𝑟=radial distance from the axis 

The joints present in the body allows the form to transform into a variety of shapes, thus 

giving an infinite number of moments of inertia variations. The concept of manipulating 

the shapes the body creates to influence the moment of inertia can be applicable to 

increase body rotations, such as in sports like figure skating and ballet. Inverse dynamics 

is the use of visual studies to determine the physics applications and equations on the 

body segment in question. Similar to the general applications of physics in dynamics, 

biomechanists also implement rigid body diagrams and inverse dynamics to comprehend 

the effects of Newton’s Laws to calculate the forces acting on the human body. These 

concepts, such as moment of inertia and torque, can be combined to articulate the joint 

rotation, strength, and power. 

 Equilibrium is when the sum of forces and/or torques equal zero. This concept is 

split into static equilibrium, as shown with Eq. 3 and Eq. 4, and dynamic equilibrium, as 

(2) 
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demonstrated with Eq. 5 and Eq. 6. Static equilibrium is when the object is experiencing 

no movement while dynamic equilibrium refers to when the object exhibits acceleration. 

�𝑭𝑭 = 0 

�𝑻𝑻 = 0 

�𝑭𝑭−𝑚𝑚 ∙ 𝒂𝒂 = 0 

�𝑻𝑻− 𝐼𝐼 ∙ 𝜶𝜶 = 0 

Static equilibrium can be used to calculate the center of gravity of the human body in the 

anatomical position. In the anatomical position, the general location of the center of 

gravity is 57% of the male height and 55% of the female height [11]. The center of 

gravity within the human body can change locations as the body changes shapes in 

accordance to the joint combinations created. Traditionally, within the clinical setting, 

center of gravity is determined with two techniques: the reaction board method and the 

segmental method. The reaction board method uses a rigid board with a scale to measure 

the reaction force at the feet. The segmental method uses mathematics to break up the 

body into segments to achieve the calculations, such as utilizing Eq. 4 to determine the 

overall center of gravity of the body by understanding the sum of torques on body 

sections.  

Equilibrium can also be used to understand the concept of balance, a tradeoff 

between stability and mobility, by using the sums of forces and/or torques. In 

kinesiology, balance is deemed as the relationship between controlled body position and 

relative base of support in dynamic and static movements. To improve balance, based on 

mechanical principles, there should be an adjustment of posture and body placement. In 

(3) 

(4) 

(5) 

(6) 
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the concept of balance, it is important to acknowledge that stability and mobility are 

inversely proportional. Balance is closely related to posture and in turn proves a 

dependency on the body’s center of gravity. The determination of the center of gravity, 

vertically and horizontally, relative to the base of support will allow for the identification 

of mobility verses stability in the presented pose. The base of support is defined as the 

area created by the supporting elements of the body, such as the distance between the feet 

as well as the feet themselves. For example, in martial arts, a middle stance (a wider set 

stance) creates ample stability with the lowering of the center of gravity, but it is more 

difficult to move quickly out of this portion. Alternatively, a fighting stance (shoulder 

with apart, constant movement on the ball of the feet kind of stance) allows for ease of 

travel or mobility across the floor and quicker executions of defensive and offensive 

movements such as kicks and blocks, but this position proves to be less stable and makes 

one more susceptible to sweeps and impromptu takedowns. Good balance is dependent 

on good posture as determined with the mechanical principles, such as with force and 

pressure concepts. With the combination of the angular kinetics in biomechanics and 

balance principles, it becomes possible to determine the sides of the body that require 

more support, that are weaker, or unsteady and provide the information to reestablish 

overall stability [11]. 

Joint movements and rotation all differ depending on the type of joint located at 

that particular site, such as hinge, ball and socket, pivot, saddle, plane, and gliding joints. 

The main joints necessary for this study include the hinge, ball and socket, and gliding 

joints. The gliding joints are located in the ankles, the ball and socket joints are in the 

hips, and the hinge joints are in the knees [16]. Each joint contains the potential of 
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experiencing three rotational movements and six degrees of freedom, as shown in Figure 

1, where the rotation occurs around the rotational axis of each joint [12]. 

 

Figure 1: The identification of the translational and rotational movements on 
three axes with six degrees of freedom for joint functions as shown on this joint located 

in the spine [12]. 
 

Hip joints move from lateral to medial and vice versa, as well as from anterior to 

posterior and vice versa. So, the hip movement is from front to back (posterior to 

anterior) and outside to center (lateral to medial) [17]. The hip joint has a maximum, 

healthy hip rotation between 110 and 125 degrees [31-32, 34]. The knee joint’s 

movement if from anterior to posterior, with a full range of motion between 135 and 141 

degrees [17, 33-34]. The ankle functions in any direction along the surface of the joint 

interaction, with a range of motion between 48 and 55 degrees [17, 34]. The 

comprehension of the hips, knee, and ankles joint movement capabilities will enhance 

and contribute to the understanding of human movements during gait. 
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Transfemoral Amputations, Prosthetics, and the Fitting Process 

A prosthetic refers to an artificial replacement to a body part for the sake of 

functionality capabilities and/or cosmetic purposes. Typically, prostheses for the joints, 

such as knee, hip elbow, are implants as part of the joint. A removeable prosthesis, such 

as for the legs and arms, may have various extensions, such as the feet and hands, for 

different functions. Given the continual growth of technology and the comprehension of 

biomedical developments, the line between removeable and implanted prosthesis has 

blurred with the rise of devices that are capable of responding to neural firings and 

signals, like cochlear implants and hearing aids [8].   

A transfemoral amputation is the subtraction of the leg above the knee. An 

amputation above the knee requires the removal of thigh tissue and part of the femoral 

bone, thus creating the stump. The cause of a transfemoral amputation vary from 

infection, trauma, vascular compromise, tumors and congenital impairments. As with any 

surgery, transfemoral amputations also experience complications, like muscle atrophy, 

surgical site infections, dehiscence (the splitting or bursting of the wound), and wounds 

from the stump and prosthetic interaction. Psychological complications may also occur 

where patients may experience a range of emotions, such as post-traumatic stress disorder 

(PTSD) and depression, due the sudden loss of the limb or a traumatic amputation 

experience [9-10].  

Transfemoral prosthetics allow for the reestablished mobility for the amputee. A 

transfemoral prosthetic is broken down into four main parts: (1) socket, (2) knee joint, (3) 
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shin/pylon tube, and (4) foot and ankle apparatus, as shown in Figure 2. The knee joint is 

split into two types, microprocessor or non-microprocessor. The microprocessor knee 

joint is a more advanced version of the non-microprocessor because it utilizes hydraulic 

and pneumatic systems to create a smoother bend on the knee and requires less effort 

from the wearer [18-20]. The microprocessor knee joint tends to be heavier and bulkier 

than the non-microprocessor knee joint due to the mechanisms involved in the apparatus 

and they have a load baring weight limit [19-20]. The non-microprocessor knee joint is a 

mechanical hinge joint that relies on the movement the wearer provides through body 

actions [18-20].  

 

Figure 2: A transfemoral prosthetic breakdown of parts, information for patients 
[10]. 
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Patient comfort is determined by the stump and socket interaction, thus deeming the 

socket as one of the most important fits to establish during the process [7]. The size and 

type of the prosthesis elements presented in Figure 2 are determined by insurance 

allowance and clinical fitting charts used during the fitting process, similar to that shown 

in Figure 3.  

 

Figure 3: Ottobock catalog order example based on the given patient measurements [13]. 

The prosthetics fitting process for transfemoral amputations consists of a range of steps 

called the Benchmarks, along with the additional fitter modifications to adjust the fit per 

patient. In the clinical environment of prosthetics and orthopedics, there are specified 

standards used to fit prosthetic legs on a patient: (1) product standards, (2) comfort of the 

user or patients’ feedback, and (3) fitter’s, a certified prostheses and orthotics technician, 

experience, and (4) trial and error, also categorized as observational gait analysis [3]. The 

standards are broken down into the following steps [3-5]:  
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1. Stump position  the drawing of reference lines, anterior and lateral, on the 

stump while it is in rest position and experiencing loads. 

2. Bench alignment  the manufacturing recommendations for alignment and 

reference lines placement that accompany each part used to assemble the 

prosthetic limb. 

3. Static alignment  the standing and balance capabilities of the user in the 

prosthetic with the gathered alignments from the stump position and bench 

alignment. (NOTE: The user should be able to maintain balance as well as move 

the leg with relative ease, and ideally the knee joint and foot should be aligned 

with the hips.) 

4. Dynamic alignment  testing and analyzing the leg during walking and making 

further adjustments accordingly  

Through the successful alignment, a process that will be achieved by following the 

above-mentioned steps, and with rehabilitation, the patient should be able to achieve 

minimal asymmetry in walking and standing while wearing the prostheses [3]. Clinically, 

the alignment process is not an individualized process, but rather a generalized system of 

steps created by the manufacturer to provide guidance for fitting measurements that is 

accompanied with an element of error [5]. Since every individual’s amputation and 

“stump” is different, the final individualized “adjustments” must be done during the 

dynamic alignment step. It is vital that the patient be completely comfortable when 

standing and walking with their prostheses. The additional adjustments are subjective and 

excessively dependent on the skills the technician achieves over time and with their own 
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progressive experience. Due to the subjective nature of the method, the patient’s 

prostheses fitting process is subjected to a wide range trial and error [3].  

 

Gait analysis – Natural Bipedal vs Amputee Locomotion 

 Natural bipedal human locomotion is the organic walking pattern of a human 

being. The studies of human gait revealed that the hip-leg relationship is similar to the 

motion and physics of a double pendulum, as shown in Figure 4. 

 

Figure 4: Double pendulum created by the hip-leg relationship during the gait cycle [2]. 

A gait cycle is when one heel rolls off the ground and swings before reestablishing 

contact with the ground. This cycle is broken up into the swing and support phases, 

where the support phase is theorized to occupy sixty percent of the gait cycle and the 

swing phase takes up forty percent. The support phase is when the foot touches the 

ground and the swing phase directly follows, where the foot is making no contact with 
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the ground. The support limb shifts the weight from one side of the pelvis to the other, 

thrusting the upper body forward for momentum and to reestablish balance. The 

movement of the hips during the walking cycle creates a figure eight motion that 

demonstrates the redistribution of weight. The gait cycle is divided into seven main parts, 

as shown in Figure 5: 

1. Initial contact  lead leg’s heel strikes the ground and hips rotate forward and 

adjust weight to lead leg to prepare for back leg’s take off, while the back leg’s 

toes maintain ground contact. 

2. Loading response  lead leg’s foot fully plants on the ground and hip is fully 

rotated to transfer full body weight onto this leg, while the back leg begins to 

leave the ground. 

3. Midstance  lead leg takes on all of the body weight thus making it the support 

limb, while the back leg is making its way from the back to the front of the body. 

4. Terminal stance  lead leg’s heel begins to roll off the ground, while the back 

leg’s heel begins to touch the ground in front of the body and the hips shift 

downwards to begin shifting weight. 

5. Pre-swing  the back leg is now becoming the support limb, while the lead limb 

is entering the swing phase thus continuing the transfer of weight from this leg to 

the new support limb.  

6. Mid-swing  the back leg takes on all of the body weight, while the lead leg 

swings to regain its position in front of the body. 

7. Terminal swing  the lead leg reestablishes contact with the ground. 

 



16 
 

 

Figure 5: Natural Bipedal locomotion: seven main motion phases [2]. 

Ideally, a patient with both natural legs present distributes their weight 50/50 on both 

sides to maintain symmetry and promote the most optimal transition of weight and 

balance maintenance for an idealized gait cycle. For amputees, the transfer of load is 

unsuitable due to the reidentified center of gravity that accompanies a missing limb. The 

natural leg typically adopts more than fifty percent of the body weight to compensate for 

the missing limb and maintain some balance and stability [2]. As shown in Figure 6, the 

prosthetics gait visibly differs from that of a natural bipedal locomotion, because the 

center of gravity alterations have contributed to an over-compensation in walking and 

standing. With a transfemoral unilateral amputation, the prosthetic greatly affects that of 

the wearer. Studies show that they tend to self-adopt an 8.6 percent slower gait speed 

with an approximately 65 percent more energy exertion and an increase to 49 percent 

more oxygen consumption when compared to a patient with both natural legs [9]. 

 

Figure 6: Leg amputee walking cycle, with a visual representation of how a leg 
prosthesis impacts the gait cycle. 
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The goal of any leg prothesis is to have the gait on an amputee closely resemble that of 

natural bipedal locomotion, while achieving as close to symmetrical motions and stances. 

The mirroring of natural bipedal gait in a leg amputee’s walking cycle should be possible 

with rehabilitation and adequate prosthesis fitting and alignment [3].  
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CHAPTER 3 – METHODOLOGY  

 The comprehensive analysis of gait through symmetry, center of mass, and 

balance was achieved with the use of three software applications, Maya, Solidworks, and 

MatLab. The calculations of the natural bipedal structure and the transfemoral amputee 

structure were accomplished with the assistance of all of the previously mentioned 

softwares working in conjunction with each other. This section breaks down the test 

preparation required for each application and the important equations and data needed to 

achieve the analysis. 

Test Preparation 

Maya Models 

Maya is an Autodesk 3D animation software typically used to create movies and 

short films, but this software has been utilized for engineering applications and anatomy 

analysis. Maya is simply a stepping stone to reach the path of engineering calculations 

and analysis. In Maya it is far easier to create close to real models to represent the organic 

form of human life and anatomy, because Maya creates that platform to not only model 

but also control and animate the models created. This software was built for mesh 

manipulation to create entertainment, but in this instance, Maya was implemented to 

create the basis for the engineering applications. 

As mentioned above, the goal of a leg prosthesis is to provide the wearer with a 

gait as closely related to normal natural bipedal gait as possible. To establish basic human 

gait calculations and a baseline for future comparisons, such as center of gravity, 

equilibrium and torque, it was first important to model the seven steps of natural bipedal 
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locomotion, as shown in Figure 5, in the Maya 3D animation software. The natural 

bipedal model created an even platform for comparison once placed next to the Maya 3D 

modeled figure of a transfemoral amputee. The steps listed in Table 1 provide a further 

breakdown of the Maya modeling, rigging, and animating process. 

 

Table 1: Maya Process – Modeling, Rigging, and Animating. 

Steps Actions 

1 Obtain reference images for the front and side views of the human body 

(silhouetted images were easier to use in this case) 

2 Bring in those images as reference planes in Maya (select window, click 

View>Image Reference) 

3 Model the figure with the lowest resolution manageable, but with enough 

resolution that the model is still able to convey the concept of a figure 

(resolution = number of faces on the mesh polygon)  

4 Rig the model: change the drop down on the left from Modeling to Rigging 

5 Click the Skeleton tab > Create Joint 

6 Place the rig on the model as shown in Figure 7 

7 Click the rig then shift select click the mesh model, click the Skin tab > 

Bind Skin 

8 Check the paint weight of the skeleton by first clicking the mesh then 

clicking the Skeleton tab > Paint Weights (white, when the joint is selected 
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in the paint weights window, means complete influence, while black means 

no influence) 

9 Create IK handles for the legs by clicking the Skeleton tab > Create IK 

Handles 

(click from the top leg joint to the ankle = IK 1, from the ankle to the 

midtoe = IK 2, and from the midtoe to the toe = IK 3). 

10 Finally, create the controls by creating spline circles. Click the 

Curves/Splines tab> click the circle 

11 Move and size the circle as fit, then click the Modify tab > Freeze 

Transformations 

12 Click the spline then shift select the joint. In the rigging drop down, click 

the Constraints tab > Parent 

13 Continue steps 10 – 12 until your model looks like Figure 8 and your 

outliner looks like Figure 9 for controls (CTRLS) 

14 Select the controls and use QWER to move and manipulate your model and 

move the model into the correct positions (Q=select, W=translate, E=rotate, 

R=scale) and press ‘S’ to key the position. 

15 For the amputee model, click the model, hold down right click and move 

the mouse to faces. Select the necessary faces, and simply delete a leg from 

the from the knee down. Select the edges and fill the hole with the Bridge 

tool 
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Figure 7: Maya mesh model with skeleton (the colorful system within the gray body). 

 

Figure 8: Maya bound mesh model with control splines (the blue, green and pink lines). 
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Figure 9: The outliner of the control system (spline curves and IK handles). 

Repeat steps 1 – 3 with prosthetic reference images in place of the human body 

references to model the prosthetic limb for future use and analysis. 
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Maya to Solidworks conversions 

 Now that the models have been created, it is time to transition between the art and 

engineering worlds. To bridge the gap between engineering and modeling, or in this case, 

Maya and Solidworks, first the Maya files must be converted to something that is 

recognizable to Solidworks. Maya saves its files as either .ma or .mb, neither of which 

can be read by Solidworks, let alone allow for further analysis or manipulation. With the 

Maya file, follow the steps listed in Table 2 to obtain a .stp file, a Solidworks friendly file 

that can not only be recognized but also allow for further manipulation and analysis. 

 

Table 2: Converts a .ma file to a .stp file in Maya. 

Steps Actions 

1 Picking up from the last step in Table 1, click the Display tab > Heads up 

Display > Poly Count 

2 Select the mesh model, click the Modify tab > Convert > Polygons to 

Subdivs ⬜ 

3 In this window, make sure the Convert Faces count is higher than that of 

the polygon that is being converted (Ex: 100 faces on polygon, then make 

the convert polygon number 101), then click apply. 

4 Select the mesh model again, click the Modify tab > Convert > Subdivs to 

NURBS. 
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5 Save the file. Then click the File tab > Export All. Change the drop down 

to STEP file (.stp), name the file and choose a location before clicking 

export. 

The .stp file saved from this process will only save the last “position” of the model in 

Maya, so be sure to export all the parts necessary using the above steps. In this instance, 

the first four steps of the walking process, as shown in Figure 5, were exported as 

separate .stp files. The body in segments, such as the arm, leg, torso, and head with neck, 

the prosthetic leg modelled (as a whole and parts), and the amputee model with a 

variation of stump lengths were also be exported as individual .stp files for further 

analysis. 

Maya MEL code 

 In this section, the animation created using Table 1 was utilized to gain rotational 

joint data from the keyed frames and joint movements. To do this, the study of MEL code 

(Maya embedded language) was initiated to obtain an understanding of the actions and 

results that were desired from this code. The primary actions of the code were as follows: 

a. Locate the joints within the model 

b. Identify the joint orientation of specified joints  

c. Isolate joint orientation (specifically z rotation) for primary key frames 

d. Store isolated values in a matrix 

e. Display isolated values 



25 
 

In this instance, the stored values from point d were manually inputted into an excel file 

and saved in the same folder as the future MatLab code in preparation for the MatLab 

interface interaction and manipulation. 

Solidworks Analysis 

 Solidworks, an engineering, technical analysis and modeling application, assisted 

in giving the center of mass information that is necessary to further the research. Follow 

the listed steps presented in Table 3 to accomplish this for human body center of mass 

results. 

 

Table 3: Human body center of mass analysis – natural bipedal and amputee male 
anatomy. 
 
Steps Actions 

1 Open the .stp file saved from Maya with File > Open > change drop down 

on bottom right to STEP > choose file > click Open  

2 A window will pop up that says, “Do you wish to run Import Diagnostics 

on this part?”, click Yes. 

3 In Run Diagnostic options window, click the “Attempt to heal all” option. 

4 If there is a Faces error, click the “Attempt to heal all Faces” option. 

5 Once everything has been successfully healed with no errors left, click the 

green check mark on the top left of the window to apply. 

6 When the window pops up stating “Do you want to proceed with feature 

recognition?”, click yes 
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7 Click then right click the Materials tab in the tree on the left side 

8 Click the “Edit Material” option 

9 Choose a material and click Apply and Close (in that order) 

10 Click the Imported# tab in the tree on the left side 

11 Click the Evaluation tab in the bar present at the top 

12 Click Mass Properties button 

13 Alternatively, Features tab > Reference Geometry > Center of Mass 

14 Click the arrow at the top left to reveal the file and other options, click 

View > Hide/Show > Center of Mass 

15 Save the .stp file as Part and name the file with File > Save As 

16 File > New > Drawing  

17 Select or browse for the newly saved item WITH the center of mass icon 

drop 

18 Place the front and side views of the model in the desired locations and 

then click the green check mark to apply 

19 Click the Insert > Model Items > select one of the views and change the 

drop down to “Entire model” 

20 In the reference geometry section, select the center of mass symbol  and 

click the green check mark to apply 

21 Repeat step 14 to display the marker 
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22 Click the Annotate tab > Smart Dimensions, to create dimensions from the 

center of mass icon to the (0, 0, 0) location of the model to get xyz values 

of the marker’s location 

 

Follow Table 4 to gain the center of mass for the prosthetic limb. These steps differ from 

the ones presented in Table 3, because different materials and part assemblies are 

involved in the overall analysis of this prosthesis. The materials for each part of the 

prosthetic, as shown in Figure 2, are as follows: 

a. Socket – plastics, such as polypropylene, or light metals, such as aluminum or 

titanium [21] 

b. Knee Microprocessor – hydraulic or pneumatic systems made of PTFEs with a 

hard plastic or metal components casing [25] 

c. Knee non-microprocessor – hard plastic or metal components [26] 

d. Pylon tube – stainless steel, aluminum, or titanium [22-23] 

e. Ankle – stainless steel or titanium [27] 

f. Foot – wood or plastic covered with a foam or rubber outside [21,24] 

A combination of these materials were assigned to the prosthetic parts and assembled in 

Solidworks to study how different materials may alter the center of mass to height ratios. 
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Table 4: Prosthetic leg material assignment, parts assembly, and center of mass analysis  

Steps Actions 

1 Follow the steps 1 – 9 presented in Table 3 to Open, assign materials listed 

above to the appropriate .stp file part, and save (be sure to save the part 

files in the same folder as the original .stp file for assembly to be 

successful) 

2 Create an assembly with File > New > Assembly > choose a part of the 

prosthetic apparatus to begin with (starting with the extremities, such as the 

socket or foot, is recommended) 

3 Click the green check mark at the top left corner to apply 

4 Import another part with Assembly tab > Import components > choose the 

next part file (recommended: choose the next prosthetic part in the 

hierarchy, such as the knee processor if starting with the socket or the ankle 

if starting with the foot)  

5 Hover the mouse next to the existing part and click to place the new part 

down 

6 To add constraints to the parts, go to the Assembly tab > Mate  

7 Click the center vertex on the inner circle of both parts on the sides that 

need to touch 

8 Select Coincide, then click the green check mark in the top left corner to 

apply 

9 Repeat steps 2 – 8 until the assembly resembles Figure 10 
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10 Repeat steps 11 – 12 and/or steps 13 – 22 in Table 3 to get the Mass 

Properties of the Assembly 

11 After repeating step 22 in Table 3, add annotation balloons by clicking the 

Annotation tab > Click the drawing view > click Auto Balloons 

12 Add a bill of materials to show the materials used for each prosthesis 

element by clicking the arrow in the top left to reveal File and other tabs. 

Click Insert >Table> Bill of Materials > select the view with the balloons > 

click on the screen to drop the bill on materials on the drawing > click the 

green check mark to apply  

 

 

Figure 10: Solidworks assembly of prosthetic limb parts with assigned materials. 
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 For all of the models, it was important to establish the center of mass’ location in the xyz 

directions as well as the size of the figure in the same directions. This collected data 

helped with establishing a ratio to compare the center of mass locations exhibited on the 

different models. The equation presented below, Eq. 7, were used to establish the ratios 

for comparison: 

𝑥𝑥𝐴𝐴
𝑥𝑥𝐵𝐵

= 𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑟𝑟 𝑜𝑜𝑜𝑜 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑟𝑟𝑚𝑚𝑐𝑐𝑟𝑟𝑜𝑜 

Where 𝑥𝑥𝐴𝐴 = center of mass position from (0, 0, 0) 

 𝑥𝑥𝐵𝐵 = total length  

For further analysis, the percent change equation, Eq. 8, was used to compare the center 

of mass ratios to the previous study. The previous study showed that a 3.7 percent change 

in symmetry is insignificant, while any asymmetry percentages that are 10 percent and 

above involk gait hinderence and disabilities [43]. 

𝑝𝑝𝑐𝑐𝑟𝑟𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐 𝑐𝑐ℎ𝑚𝑚𝑐𝑐𝑎𝑎𝑐𝑐 = �
𝑁𝑁𝑐𝑐𝑁𝑁 𝑣𝑣𝑚𝑚𝑣𝑣𝑣𝑣𝑐𝑐 − 𝑂𝑂𝑟𝑟𝑟𝑟𝑎𝑎𝑟𝑟𝑐𝑐𝑚𝑚𝑣𝑣 𝑣𝑣𝑚𝑚𝑣𝑣𝑣𝑣𝑐𝑐

𝑂𝑂𝑟𝑟𝑟𝑟𝑎𝑎𝑟𝑟𝑐𝑐𝑚𝑚𝑣𝑣 𝑣𝑣𝑚𝑚𝑣𝑣𝑣𝑣𝑐𝑐
� × 100 

 

MatLab Calculations 

 MatLab is a multifunctional, user friendly coding software and language that 

assisted in wrapping up and connecting all of the above-mentioned parts. The goal of this 

application was to apply the concepts mentioned in the previous chapters in mathematical 

and analytical processes through code. The codes created were constructed around the 

information one would be able to obtain from a patient, such as weight and height. Body 

(7) 

(8) 
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percentages for limb length and weight, as shown in Tables 5 – 6, were used in 

conjunction with the user input.  

 

Table 5: Weight percentages of limbs based on total body weight [28]. 

Segment Male Female 

Head 8.26% 8.20% 

Whole Trunk 55.1% 53.25 

Thorax 20.1% 17.0% 

Abdomen 13.1% 12.2% 

Pelvis 13.7% 16.0% 

Total Arm 5.70% 4.97% 

Upper Arm 3.25% 2.90% 

Forearm 1.87% 1.57% 

Hand 0.65% 0.50% 

Forearm & Hand 2.52% 2.07% 

Total Leg 16.7% 18.4% 

Thigh 10.5% 11.8% 

Leg (Shank) 4.75% 5.35% 

Foot 1.43% 1.33% 

Leg (Shank) & Foot 6.18% 6.68% 
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Table 6: Length percentages of limbs based on total body height [29]. 

Segment Length 

Head & Neck 10.75% 

Torso 30.00% 

Upper Arm 17.20% 

Lower Arm 15.70% 

Hand 5.75% 

Thigh 23.20% 

Calf (Shank) 24.70% 

Foot 14.84% 

 

In Table 6, the Foot length percentage is the length of the sole. To find the height of the 

foot from the ankle to the ground, simply add up all of the percentages (not including the 

foot) and subtract that value from 100%. 

The MatLab Calculations section was broken down into the following sections for 

ease of comprehension and analysis using the percentage data presented in Tables 5 – 6: 

a. Center of Mass Percentages 

This section used the data provided by the Solidworks Mass Properties analysis of the 

male body in anatomical position. The main purpose is to obtain ratio using Eq. 7. In this 

instance, xA is the center of mass xyz coordinate and xB is the total length, width, height 

of the model. 
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a. Equilibrium and Rotational Torque 

This code used a modified version of Eq. 1, and calculate rotational torque based on the 

legs angled positions with respect to the ground (Tr) the limb may take during the gate 

cycle using Eq. 9 – Eq. 11, as shown below. Equilibrium was tested using Eq. 4, the sum 

of torques, setting the left and right sides of the body equal to each other. 

 

𝑇𝑇𝑟𝑟 = sin(𝜃𝜃) ∗ 𝑣𝑣 ∗ 𝑊𝑊 
𝑇𝑇𝑟𝑟 = cos(𝜃𝜃) ∗ 𝑣𝑣 ∗ 𝑊𝑊 
𝑇𝑇𝑟𝑟 = tan(𝜃𝜃) ∗ 𝑣𝑣 ∗ 𝑊𝑊 

  Where l=length of the leg  

   θ=angle of rotation at the joint in the z – direction 

   W=weight of the limb 

The equation usage was dependent on the leg’s position and weight, as well as the three 

joints’ (hip, knee, and ankle) relationship to each other during the main phases of gait. 

The implication of loops, mainly if/else statements and for loops, assisted in achieving a 

self-sufficient analysis code. 

(9) 

(10) 
(11) 
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CHAPTER 4 – DATA AND ANALYSIS  

 This chapter discusses the results of the individual sections and provide a 

discussion for the respective parts. The analysis began with the Maya applications and 

results of the modeled and animated walk cycle for both bipedal natural male anatomy, as 

well as an amputee with and without a prosthetic limb for comparisons. The coding 

software in Maya MEL code, was addressed and manipulated to provide sample data and 

results from the animated segment. Solidworks analysis acted as the transition between 

art and engineering by providing analytical center of mass data on the Maya models. This 

discussion continued with the MatLab code calculations and algorithms that evaluated the 

collected and given data.  

Maya Models 

A male figure was used to create the models for the bipedal and amputee anatomy 

for this portion of the study. The walking cycle presented in Figure 5 was replicated with 

Maya modeling and animating to demonstrate the software capabilities of motion and 

shape likeness to human movements, as presented in Figures 11 – 17. 
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Figure 11: Maya rendition of walking cycle step 1, heel strike (initial contact), as 
presented in Figure 5. 

 

 

Figure 12: Maya rendition of walking cycle step 2, loading response (foot flat), 
as presented in Figure 5. 



36 
 

 

Figure 13: Maya rendition of walking cycle step 3, midstance, as presented in 
Figure 5. 

 

 

Figure 14: Maya rendition of walking cycle step 4, terminal stance (heel off), as 
presented in Figure 5. 
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Figure 15: Maya rendition of walking cycle step 5, pre-swing (toe off), as 
presented in Figure 5. 

 

 

Figure 16: Maya rendition of walking cycle step 6, initial and mid-swing, as 
presented in Figure 5. 
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Figure 17: Maya rendition of walking cycle step 7, terminal swing, as presented 
in Figure 5. 

 

When finished and compiled in post-production (video editing software), it would be 

easy to see the bipedal locomotion in action with the presented model and the steps 

mentioned above working in unison to propel the body into a forward moving path.  

With this model set in place, it facilitated the development of the amputee with a 

prosthetic for gait cycle animation. It was evident that this cycle presented some 

differences when compared to that of the locomotion presented above, as shown in 

Figures 18 – 24. 
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Figure 18: Maya rendition of walking cycle step 1, heel strike (initial contact), as 
presented in Figure 6. 

 

 

Figure 19: Maya rendition of walking cycle step 2, loading response (foot flat), 
as presented in Figure 6. 
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Figure 20: Maya rendition of walking cycle step 3, midstance, as presented in 
Figure 6. 

 

 

Figure 21: Maya rendition of walking cycle step 4, terminal stance (heel off), as 
presented in Figure 6. 
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Figure 22: Maya rendition of walking cycle step 5, pre-swing (toe off), as 
presented in Figure 6. 

 

 

Figure 23: Maya rendition of walking cycle step 6, initial and mid-swing, as 
presented in Figure 6. 
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Figure 24: Maya rendition of walking cycle step 7, terminal swing, as presented 
in Figure 6. 

 

When the prosthesis gait phases were compared to the natural bipedal locomotion, it was 

evident that the shift of weight between the legs differs. In the prosthesis gait 

representation, the hip dips more to the natural leg when the natural leg is switching to 

the role of the support leg. This occurs because the prosthetic does not present the same 

range of motion capabilities that the natural leg demonstrates. Oftentimes, the muscle 

atrophy and the weight of the prosthetic limb can cause a dramatic alteration in gait 

cycles. These changes are often exhibited in the over-compensation of the natural leg 

baring more weight and an over rotation of the hips to lift and carry the prosthetic limb 

forward. 
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Maya MEL Code Output 

The ideas and concepts of coding language translate between softwares, so the use 

of the knowledge gained from previous MatLab coding experience bridged the gap 

between the unknown of MEL code with the comfortable syntax of MatLab. For the 

results presented in Table 7 below, the concept of a for loop was applied to establish, 

write, and collect the data created by the IK handle bound joint rotations in the natural 

gait animation. The significant figures presented in Table 7’s data hold importance to 

replicate the joint locations within the animation for further testings in the future. 

 

Table 7: MEL code output of the joint rotations in the z directions of the lower limb 
joints in degrees. 
 

 

In the Maya model, rigging, and animation, the chosen naming conventions are as shown 

above in Table 7, where L and R represents left and right, respectively, and LEG and 
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HIPS stands for the hip ball and socket joint and pelvis bone, respectively. The z rotation 

values vary between positive (anterior rotation) and negative (posterior rotation) 

depending on the direction of rotation and the IK handle control movements. An IK 

handle is an inverse kinematics constraint that allows for ease of joint movements for the 

animation. The chosen time points, as presented in the KEYFRAME TIME column, of 

observation are based on the conventional walk cycle animation method, as shown in 

Figure 25. These time periods indicate the vital poses necessary to mark in order to 

achieve a realistic, smooth character gait. The magnitude of the values presented prove to 

be smaller than expected for some of the LEG_L, LEG_R, KNEE_L, and KNEE_R 

rotational numbers. This could be due to the constraint that the IK handles placed on the 

joints, their rotation, and the manipulation. IK handles are the most efficient and known 

way to create controls for leg movements, because it bypasses the parent joint hierarchy 

and moves the lower limb in the similar way that it would function naturally. Naturally, 

the foot movement is the primary driving force that dictates weight distribution and hip 

placements.  

 

Figure 25: Traditional animation walk cycle guidelines [30]. 
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Below, Figures 27 – 29 show the graphed output presented in Table 7 for further 

comparison and visual comprehension, where the LEG_L and LEG_R values are 

multiplied by negative one before graphing due to an IK handle constraint property. 

Figures 26 and 30 demonstrate the typical hip rotation during natural gait and the hip, 

knee, and ankle joint rotations, respectively, completed during previous studies. In 

comparing Figures 29 – 30, it is evident that the MEL code HIPS output data is relatively 

close to the presented graph, where 25 keyframe time is equivalent to 100 Percent gait. 

Figure 27 (lead leg) was used for comparison with Figure 26 because the previous study 

data in this figure is based on the lead leg of the patient. When comparing both figures, it 

is evident that the MEL code output data for the left leg (Figure 27) closely resembles the 

pattern presented in Figure 26 with minor variations of error. The error could be 

considered minimal since each individual exhibits slight, natural gait deviations. These 

similarities validate that the animation used for analysis accurately depicts the human 

walk cycle. 

 

Figure 26: Joint angle data (degrees) of lead leg, where solid line = hip, dashed 
line = knee, and dotted line = ankle [35]. 
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Figure 27: Left leg (lead leg) joint movements, z-axis, of Maya model using MEL code 
output from Table 7. 

 

 

Figure 28: Right leg joint movements, z-axis, of Maya model using MEL code output 
from Table 7. 
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Figure 29: Hips/pelvis rotation, z-axis, of Maya model using MEL code output from 

Table 7. 

 

Figure 30: Hip rotation data, where solid black line = hip rotation, solid grey 
lines = interval of rotation, and the dotted lines = maximum and minimum 

rotation locations. [42]. 
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Solidworks Analysis 

 In Solidworks, three primary model groups were anaylized for center of mass 

changes and comparisons:  

a. Natural Bipdal Locomotion 

b. Natural Bipedal vs Amputee Anatomies 

c. Natural vs Prosthesic Legs 

Natural Bipedal Locomotion 

For the natural bipedal locomotion, the first 4 steps of the walk cylce (Figures 11 

– 14) were translated to a readable Solidworks document for further analysis. Since the 

last 3 steps of the walk cylce mirror the first 3, an analysis of only 4 out of 7 steps was 

necessary to gain the desired information. For these models, they were tranferred to 

Solidworks using the steps presented in Table 2 and the center of mass for each model 

was established using the steps stated in Table 3. The results are as presented in Figures 

31 – 38, as shown below. 
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Figure 32: Solidoworks drawing of walking cycle step 1, heel strike (initial contact) 
with center of mass location, as presented in Figure 5. 

 

Figure 31: Solidworks 3D model of walking cycle step 1, heel strike 
(initial contact) with center of mass, as presented in Figure 5. 

 



50 
 

 

  

Figure 33: Solidworks 3D model of walking cycle step 2, loading response 
(foot flat) with center of mass, as presented in Figure 5. 

 

Figure 34: Solidworks drawing of walking cycle step 2, loading response 
(foot flat) with center of mass location, as presented in Figure 5. 
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Figure 35: Solidworks 3D model of walking cycle step 3, midstance, with 
center of mass, as presented in Figure 5. 

 

Figure 36: Solidworks drawing of walking cycle step 3, midstance, with 
center of mass location, as presented in Figure 5. 
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Figure 37: Solidworks 3D model of walking cycle step 4, terminal stance 
(heel off), with center of mass, as presented in Figure 5. 

 

Figure 38: Solidworks drawing of walking cycle step 4, terminal stance (heel 
off), with center of mass location, as presented in Figure 5. 
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Immediately, it is obvious that the overall height of each stage presented above are a 

range of values and will even differ from the height of the model in the set, anatomical 

position. The reason for this change in height is simple. When humans walk, each step is 

executed with force and momentum and most importantly, the hips sink into the stance to 

help with reestablishing stability during each phase. The hip’s figure eight movement, as 

discussed in Chapter 2, is the natural motion that occurs during bipedal locomotion. 

Figure 34 shows the shortest overall height because in animation, this is called the “down 

pose”, as shown in Figure 25, or the lowest point the hips go during the gait process. 

Constrastingly, Figure 36 demonstrates the tallest overall height because in animation this 

is known as the “up pose” and the highest point in the figure eight that the hips reach 

during a gait cycle. 

For the center of mass, the main axis of concern is the z-axis alterations, since the 

body experiences the most anatomoical position changes in this direction. Based on the 

dimensions provided in Figures 32, 34, 36, and 38, it is evident that the center of mass is 

constantly fluctuating as the human body executes a step in natual locomotion. Of the 

four stages that are displayed, the biggest change was exhibited in step 1, as shown in 

Figure 32, where the z-axis dimesion is 1.58 inches from the center of the body. As stated 

before, the base of support is the most vital element of stabilty. Concluding that the 

expanded base of support, when compared to the anatomically positioned body in Figure 

40, as a contributing factor is not a far off assumption. In Figure 32, the heels of the feet 

are 14.33 inches apart in the z direction, while the feet are directly next to each other in 

Figure 34. In the instance shown in Figures 31 – 32 this is the intial heel stike, the 

moment where the lead leg makes contact with the ground. Most importantly, in this  
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moment, the torso bends forward, the hips rotate and dip towards the lead leg to gain the 

momentum to propel the body forward. Knowing this information, when analyzing the 

center of mass change in Figure 38 when compared to Figure 32, the values alter 

unexpectedly. In Figure 38, the base of support is much wider than that exhibited in 

Figure 32, but the center of mass has shifted towards the back of the body. A further 

analysis of the human gait cycle expresses that this moment captured in Figure 38 is the 

moment when the weight and “lead leg” responsibility shifts from one leg to the other. 

The shift in weight from one side of the body to the other also has an effect on the center 

of mass fluctuations. The center of mass value variations are an indication of the body 

constantly attempting to regain or maintain balance during normal, natural locomotion, 

since it is known that balance is dependent on the body’s center of mass.  

Natural Bipedal vs Amputee Anatomies 

 The focus of this analysis was to determine the center of mass location differences 

between the natural and amputee anatomies using Solidworks. Understanding the 

dynamics of the center of mass enabled a better comprehension of how the loss of a limb 

alters basic balance elements. Figures 39 and 41 show 3D Soliworks models of the 

natural and amputee anatomies, where the amputee has a medium sized stump. Figures 

40 and 42 further identified the dimensions of the center of mass locations, where the x 

and z-directions were in relation to the center of the body, and the y-direction dimension 

was from the bottom of the foot.  
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Figure 39: Solidworks 3D view of natural anatomy and center of mass 
location. 

Figure 40: Solidworks drawing of natural anatomy with center of mass 
and the respective dimensions. 
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Figure 41: Solidworks 3D view of amputee anatomy with medium sized 
stump and center of mass location. 

Figure 42: Solidworks drawing of amputee anatomy, medium stump, with 
center of mass and the respective dimensions. 
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In comparing Figures 40 and 42, it is apparent that there are center of mass placement 

differs between the amputee and natural anatomies, as shown in Table 8. The value 

changes may be minute in Figures 40 and 42, but even the slightest of changes in the 

human anatomy can dramatically impact the overall symmetry and balance of the patient. 

In this instance, the amputee’s center of mass shift can be contibuted to the 

reestablishment of balance and compensation for the missing limb. The base of support is 

suddenly smaller due to the missing limb. This can be a speculated influence on the 

center of mass location shifts, since the base of support is the foundation of stability and 

mobility.  

 

Table 8: Center of mass location data from Solidworks for natural and amputee anatomy. 

Anatomy x-direction y-direction z-direction 

Natural 0.02 in 24.04 in 0.65 in 

Amputee (medium 

stump) 

0.20 in 25.76 in 0.21 in 

  

To further the study, the three different stump lengths with the single amputee 

model were tested and the center of mass was determined, as shown in Figure 41 – 46. In 

this instance, the purpose was to observe whether the three general stump lengths alter 

the center of mass or if these values are less reliant on this length change. After revisiting 

the definition of a transfemoral amputation (an amputation above the knee), the stump 

lengths were determined. A large stump length is when the amputation is right at the knee 
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joint. A small stump length is when the amputation is closest to the hip joint. While a 

medium amputation is a length between the small and large length.  

Figure 43: Solidworks 3D view of amputee anatomy with small sized 
stump and center of mass location. 

Figure 44: Solidworks drawing of amputee anatomy, small stump, with center of 
mass and the respective dimensions. 
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Figure 45: Solidworks 3D view of amputee anatomy with large sized stump and 
center of mass location. 

Figure 46: Solidworks drawing of amputee anatomy, large stump, with center 
of mass and the respective dimensions. 
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Based on the data collected from Figures 41 – 46, as presented in a compilation in Table 

9, the length of the stump does, in fact, influence the location of the center of mass. For 

example, the longer stump produces smaller y values. The x direction values showed that 

a shorter stump caused the center of mass to favor the natural leg by shifting towards it. 

The x and y shifts could be determined as the body’s way to compensate for the missing 

limb and viewed as a way to shift more of the kinetic and kinematic responsbilities to the 

whole natural leg for movement and balance. 

 

Table 9: Center of mass location data from Solidworks for different stump lengths. 

Stump size Stump 

length 

x-direction y-direction z-direction 

Small 0.99 in 0.32 in 25.99 in 0.68 in 

Medium 3.01 in 0.20 in 25.76 in 0.21 in 

Large 5.58 in 0.13 in 25.45 in 0.68 in 

 

Natural vs Prosthetic Legs 

 This analysis focused on comparing the center of mass location of a natural leg 

with the prosthetic leg. In doing so, the differences and similarities between the two 

positions revealed if the center of mass ratio that exists in a prosthetic really mimicked 

the ratios presented in the natural leg, as intended. Figures 47 and 49 show the center of 

mass marker in a 3D space on the natural and prosthetic limbs with the respective 

coordinate systems, while Figures 48 and 50 go more in depth with the necessary values 

in a 2D engineering drawing to calculate the ratios.  
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Figure 47: Solidworks 3D view of the natural leg and center of mass location. 
 

Figure 48: Solidworks drawing of natural leg with center of mass and leg dimensions. 
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Figure 49: Solidworks 3D view of the prosthetic leg and center of mass location. 

 

Figure 50: Solidworks drawing of prosthetic leg with center of mass and leg dimensions, 
and a bill of materials, combination 1. 
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In Figure 48, the overall length of the leg, xB, is 19.85 in, while the center of mass 

location, xA, is 12.39 in. When these values were substituted into Eq. 7, the ratio value for 

the natural leg, COMNL is 0.6241 or about 62.41% of the length of the leg. In Figure 50, 

following the same procedures as previously stated, xB, the total length of the prosthetic 

in the y direction, is 38.13 in, while the center of mass location, xA, is 16.28 in, thus 

giving producing a value, COMPL, of 0.4264 or 42.64% of the prosthetic. Based on visual 

observations of Figures 47 and 49, it was evident that the center of mass on the natural 

leg is located right above the knee joint (the hinge joint and point of bending). In the 

prosthesis, the marker is indicated right below the point of intended bending. The 

different locations raise many questions. Does this inequality contribute to balance issues 

and gait asymmetries? And primarily, what can be done to fix this? Materials change? 

Pylon rod lengthening or shortening?  

The natural placement of the center of mass marker on the organic leg is an 

element that cannot be changed, but can possibly be mirrored for the sake of the patient’s 

comfort, mobility, stability, and symmetry. In order to mimic the center of mass location 

on the natural leg, elements of the prosthetic limb must be altered to achieve the desired 

results. The pylon rod length is an element of the prosthetic that is dependent on patient 

height and stump length and designed to provide the connection between the ankle joint 

and the knee joint mechanisms. So, to further the study on the prosthetic leg’s center of 

mass sensitivity, additional studies were conducted that concentrated on the evaluation of 

the prosthesis with a combination of different materials. 
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Figure 51: Solidworks drawing of prosthetic leg with center of mass and leg 
dimensions, and a bill of materials, combination 2. 

 

Figure 52: Solidworks drawing of prosthetic leg with center of mass and leg 
dimensions, and a bill of materials, combination 3. 
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The major change and value of concern was the y direction center of mass number 

since the previous study comparing combination 1 and the natural leg center of mass 

demonstrated a significant difference. In Figures 50 – 52, the overall height, width and 

length of the prosthesis remain the same. These mentioned figures test a combination of 

the materials typically used to manufacture these prosthesis attributes, combination 1, 2, 

and 3, to study how the center of mass locations changed. The center of mass ratio 

calculations and locations are as shown in the compilation in Table 10. Interestingly, the 

location of the center of mass shifted in all directions with each combination of materials 

tested as shown in each of their respective bills of materials.   

The bill of materials in combination 1 consisted primarily of steels and plastic 

forms, where the steel elements are on the ankle and pylon bar. Steel (AISI 316) has a 

density of 0.289 lbs/in3, while PE high density and PTFE have densities of 0.035 lb/in3 

and 0.079 lbs/in3, respectively [36-37]. The location of the steel elements at the lower 

portion of the leg caused the center of mass to sink lower on the leg than that of the 

natural leg. After the ratio values for combination 1 and the natural leg were substituted 

into Eq. 8, the percent change for this comparison is 30.789%, where the natural leg ratio 

is the original value and the ratio for combination 1 is the new value. To recall, the 

insignificance of asymmetries is capped at below 10% for the human body, and the 

percent change for the prosthesis leg, combination 1, and the natural leg comparison is 

significantly higher. 

The bill of materials for combination 2 consisted of titanium (Ti-8Mn), steel 

alloy, and plastic forms (PTFE and PE low/med density), with densities of 0.171 lbs/in3, 

0.270 lbs/in3, 0.079 lbs/in3, and 0.034 lbs/in3, respectively [37-40]. In this combination, 
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the metal components are distributed through to the knee processor joint with steel alloy, 

contrary to the PTFE knee processor in combination 1. This alteration, in addition with 

the titanium switch, contributed to the center of mass shift towards the joint bend. 

Combination 2 presented a y value closer to that of the natural leg, but still is too small of 

a number to obtain an adequate ratio comparison to achieve near symmetry. Using Eq. 7 

to get the ratio, combination 2 has a ratio of 0.4479 or 44.79%. In following the same 

procedures presented with combination 1, for comparison, combination 2 and the natural 

leg ratios were inputted in Eq. 8 to get the percent change. The percent change for the 

combination 2 and natural leg comparison is 28.233%, which is still significantly higher 

than the acceptable anything below 10% for human body asymmetry insignificance.  

The final test, combination 3, includes PTFE, aluminum (6061-T6), and stainless 

steel (AISI 316), with densities of 0.079 lbs/in3, 0.098 lbs/in3, and 0.289 lbs/in3, 

respectively [36-37, 41]. Aluminum shows to be significantly lighter than steel and thus 

decreasing the weight and density of the overall prosthetic. Combination 3 has the center 

of mass at the knee processor joint bend and provides the most symmetry and easy of 

mobility if an amputee patient were to wear this combination of materials. Combination 3 

proved to be the most successful because the COM ratio was the closest to the COMNL 

ratio at 0.5972 or 59.72%. For the final comparison, Eq. 8 was used to calculate the 

percent change for the combination 3 and natural leg evaluation, producing a value of 

4.310%. This percent value falls under 10% thus deeming the ratio difference between 

the natural leg and the combination 3 of the prosthesis material insignificant asymmetry.  
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Table 10: Prosthesis center of mass locations for bill of material combinations. 

Material 

Combos 
x direction y direction z direction 

COM ratio in 

y 

Combination 1 2.51 in 16.28 in 5.38 in 0.4264 

Combination 2 2.59 in 17.08 in 5.11 in 0.4479 

Combination 3 2.57 in 22.77 in 4.96 in 0.5972 

 

The analysis conducted demonstrated that the material choices for the prosthetic 

component alter the center of mass location, and inadvertently affect lower limb mobility 

symmetry.  

MatLab Code 

 The MatLab code wrapped up the previous sections with analysis and comparison 

codes to further bridge the gap between the engineering and art applications. This section 

will discuss the results of the center of mass percentage calculations and the torque 

equilibrium results.  

Center of Mass Percentages 

 The center of mass percentages used the information gathered from the 

Solidworks analysis of the male body (as modeled in Maya) in anatomical position, as 

shown in Figures 53 – 54. It is important to note the location of the origin in order to 

establish the correct values for Eq. 7. In this case, the origin is at the center of the body in 

the x and z directions and at the feet location in the y direction. 
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Figure 53: Solidworks Mass Properties analysis results for COM percentages. 
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Figure 54: Solidworks Mass Properties analysis results, close-up of the 
engineering data from Figure 53. 
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The center of mass locations, as shown in Figure 54, are compiled in a Table 11, along 

with the total length, width, and height of the male model in Figure 53 for ease of 

comparison and analysis.  

 

Table 11: Center of mass and total body dimensions of male figure in anatomical 

position. 

 x (cm) y (cm) z (cm) 

Center of mass -0.029 8.361 -0.235 

Total dimensions 2.40 14.83 1.77 

 

Since the y=0 location is at the feet of the Solidworks model, Eq. 7 was arithmetically 

applied without any additional alterations where xA=8.361 cm and xB=14.83 cm, thus 

giving a ratio of 0.5638 or 56.38%. This percentage is relatively close to the center of 

mass percent logics given in the biomechanics textbook, as mentioned in Chapter 2 – 

Literature Review. In Chapter 2, biomechanics states that the center of mass location in 

the y direction is about 57% of the height of a male in anatomical position. With these 

results given from the MatLab and Solidworks combination, it can be assumed that the 

center of mass calculations of a Maya model are accurate based on the closeness of the 

values. Knowing this, the calculations of the x and z direction ratios can also be executed, 

since these percentages are not given in biomechanics reference information. For the x 

and z directions, it is important to remember that these values are the distance from the 

origin. It is known that the origin is exactly half of the x and z dimensions because this 
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figure was modeled in Maya to be perfectly symmetrical. To find the ratio, Eq. 7, with 

slight modifications, was applied as follows in Eq. 11: 

𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑟𝑟 𝑜𝑜𝑜𝑜 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑟𝑟𝑚𝑚𝑐𝑐𝑟𝑟𝑜𝑜 𝑜𝑜𝑟𝑟𝑜𝑜𝑚𝑚 𝑜𝑜𝑟𝑟𝑟𝑟𝑎𝑎𝑟𝑟𝑐𝑐 =
�𝑥𝑥𝐵𝐵2 � + 𝑥𝑥𝐴𝐴

𝑥𝑥𝐵𝐵
 

Using Eq. 11, the ratio in the x direction is 0.4879 or 48.79%, where xA = - 0.029 and xB 

= 2.40. Implementing the same equation, the ratio in the z direction is 0.3672 or 36.72%, 

where xA = - 0.235 and xB = 1.77.  

Equilibrium and Rotational Torque 

This code is meant to achieve the following purposes: 

a. Input Maya Output Data – test the torque and equilibrium on the output data 

from the Maya animation from Table 7.  

b. Given Data: Test Joint Angles – test torque and on given output data from a 

previous study, shown in Table 12 and Figure 49. 

 

(11) 
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Figure 55: Joint moments data, where solid line = hip, dashed line = knee, and 
dotted line = ankle – moment of inertia (N*m), joint angle (degrees), and GFR 

(ground reaction forces in Newtons) [35]. 
 

 
Table 12: Given data, in degrees, from a previous gait study shown in Figure 55. 

Stance 

% 

Hip 

angle 

Knee 

angle 

Ankle 

angle 

0 22 0 -3 

10 22 10 5 

20 21 20 2 

30 15 19 -3 

40 10 15 -9 

50 0 10 -10 

60 -8 5 -10 
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70 -15 2 -10 

80 -18 6 -10 

90 -18 36 -5 

100 -10 40 10 

 

c. Input Patient Data and Inverse Dynamics Method – to create a user-friendly 

version, potentially for a clinical setting, that utilizes patient input data.  

For the code to function, data was given to initiate the function of the respective codes: 

weight in pounds, height in inches, and gender, where 0 = female and male = 1. For the 

sake of testing the code’s functionality, the given data values, Table 13, were chosen 

constants for all the above purposes. The gender varied to verify both parts of the if/else 

statement conditions. 

 

Table 13: Given data for weight and height for purposes a – c.  

Weight 175 lbs 

Height 70 in 

Input Maya Output Data 

The first purpose, in addition to the parameters given by Table 13, addressed the 

obtained Maya MEL code output from Table 7. The opening of the excel file allowed for 

the analysis of the left and right attributes of each joint at each keyframe time. The output 

of the looped MatLab code was designed to display the patient gender, determine if the 

moment is stable or unstable based on equilibrium testings, choose which leg is unstable, 

and the torque difference, as shown in Table 14. The data in Table 14 demonstrated that 
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the animated Maya walk cycle experiences a great deal of instability at all selected 

keyframe times. The two negative torque differences stated an instability in the right leg 

on keyframe times 7 and 19. As shown in Figure 25, keyframes 7 and 19 are considered 

the passing poses in the animation walk cycle lingo. The passing pose is generally when 

the hips transition from the lowest position on the figure eight (down pose) to the tallest 

point (up pose). The torque difference value ranges, -2500 to 1300, could be due to the 

constraint that the input data experienced with the IK handle, as mentioned in the MEL 

code section. In comparing the Maya output data from Table 7 with given data from a 

previous study in Table 12, the Maya output data values do have abnormally small 

magnitudes overall. The range of motion that the LEG_R and LEG_L values should have 

reached in Table 7, should have been closer to 40 degrees at some point, as presented in 

Table 12. At the very least, from this segment of the study, combined the efforts of the 

Maya animation, MEL code, and the overall analysis of the torque and equilibrium. 

 

Table 14: MatLab output for Maya joint z direction rotations for set keyframes from 
Table 7. 
 

Keyframe time Stable/Unstable L/R Leg Torque Difference 

(lb*in) 

1 Unstable L 1349.5 

4 Unstable L 577.1 

7 Unstable R -1406.4 

10 Unstable L 418.3 

13 Unstable L 415.1 
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16 Unstable L -2312.5 

19 Unstable R 732.4 

22 Unstable L 57.3 

25 Unstable L 1349.5 

 

Based on the data from Table 14, the question arises: Is it possible to achieve equilibrium 

(stability) when in a dynamic state, such as gait?  

Given Data: Test Joint Angles 

 This section demonstrates the calculation of torque for the given joint angles to 

test the functionality of the written code for a modified purpose. Since this study does not 

calculate joint rotation on the left leg and right leg, performing the equilibrium exam 

becomes infeasible. For the sake of this section, the torque of each STANCE % presented 

in Table 12 was calculated, where the torque results are as presented in Table 15 for a 

male. 

 

Table 15: MatLab torque calculations for Table 12 joint angles. 

STANCE % HIP TORQUE KNEE TORQUE 
ANKLE 

TORQUE 

0 -10.7 0.0 -3.7 

10 -10.7 -148.5 -24.9 

20 1014.1 249.12 23.6 

30 788.2 40.9 -3.7 

40 -659.4 177.5 -10.7 
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50 0.0 -148.5 14.1 

60 -1199.2 -261.7 14.1 

70 -788.2 248.2 14.1 

80 910.3 -76.3 14.1 

90 910.3 -270.7 24.9 

100 659.4 203.4 -14.1 

 

The calculated torque data from the given joint angles fluctuate between very small 

negative numbers and very large positive torques. These values justify the magnitude of 

the values presented in Table 14, since the original torque values in Table 15 are in the 

1000s magnitude. The rotational torque values correlate with the amount of forward force 

and effort it takes for a human to walk with an intended direction and force. 

Input Patient Data and Inverse Dynamics Method 

This section focuses on constructing an interface that requires patient interaction 

and input information that can easily be gained from observation and traditional physical 

check-ups, such as weight, height, and gender. The joint angles would be obtained from 

inverse dynamics, such as through video or a series of pictures observation of the 

patient’s gait, similar to a compilation of gait phases as presented in Figures 5, 6, or 25. 

The video or series of pictures will allow for the collection of accurate angles of rotation 

on the hip, knee, and ankle joints without disrupting or inadvertently influencing the 

patient’s walking pattern with intermittent measuring. Utilizing the preset, constant 

parameters from Table 13, a range of joint angles were chosen to test the interface 

intended for patient use, as presented in Table 16.  
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Table 16: Data for tested angles and gender for purpose 2. 

Input Output 

Joints Angle 

(Degrees) 

Male/Female Stable/Unstable L/R 

Leg 

Torque 

Difference 

(lb*in) 

L: Hθ, Kθ, Aθ 0, 0, 0 Female Stable N/A 0.0 

R: Hθ, Kθ, Aθ 0, 0, 0 

L: Hθ, Kθ, Aθ 70, 0, 0 Female Unstable L 1009.3 

R: Hθ, Kθ, Aθ 0, 0, 0 

L: Hθ, Kθ, Aθ 10, -10, 0 Female Unstable R -721.2 

R: Hθ, Kθ, Aθ 0, -40, -5 

L: Hθ, Kθ, Aθ 0, -40, -5 Male Stable N/A 0.0 

R: Hθ, Kθ, Aθ 0, -40, -5 

L: Hθ, Kθ, Aθ 170, 0, 0 Male Unstable L 248.0 

R: Hθ, Kθ, Aθ 0, -10, 20 

L: Hθ, Kθ, Aθ 0, -40, -5 Male Unstable R -435.5 

R: Hθ, Kθ, Aθ 0, -80, 10 

 

In Table 16, L and R, represent left leg and right leg respectively, while Hθ, Kθ, Aθ, 

stands for hip angle, knee angle, and ankle angle respectively. The angles were chosen 

based on the maximum range of motion that each joint experiences in normal, healthy 

movements. The data demonstrated the code’s ability to switch between male and female 
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patient analysis information as well as adequately calculate torque and equilibrium based 

on joint angles.  

The results of all the codes are as follows, similar to the example shown in  

Figure 56: 

1. Use given information, such as weight, height, and gender, to establish 

limb length and weight for torque evaluation 

2. Provide z rotational data, either via the patient’s gait observation, Maya 

MEL code output, given input joint angles 

3. Execute the series of if/else statements and/or for loops to calculate torque 

and/or equilibrium 

4. The output provided the gender, as well as tell if the position is stable or 

unstable. Stable means the left and the right torques equal each other and 

unstable means that the two sides do not match. The output also stated 

which side the instability exists in, left or right leg and the value 

difference. 

 

Figure 56: Sample MatLab output for one set of joint rotations in the z direction. 

 

These codes’ complete functionality is multipurpose and autonomously written so data 

can be switched out and functions modified, as was done for points a-c. 
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CHAPTER 5 – CONCLUSION 

 The goal of this thesis was to (1) create a framework that assists in the 

transfemoral prosthesis fitting process by the quantification of balance in relation to 

patient comfort in lower limb prosthesis users and (2) analyze patient gait using the 

methods depicted in Figure 57. Due to the novelty of this topic, it is difficult to compare 

the results obtained from this thesis with previous studies. It was established that balance 

is a tradeoff between mobility and stability, so it is almost impossible to achieve both 

simultaneously. Balance and posture are dependent on the center of mass location, while 

symmetry is closely related to total body equilibrium. The idea of patient comfort is 

difficult to quantify, for these values are dependent on one another and the overall 

equilibrium that exists within the human body.  

The choice to work with Maya may be foreign to the engineering world, but this 

software allows functions that engineering modeling software applications do not. With 

Maya, modeling the figures to be close to real life in basic features are more feasible than 

in a software, such as Solidworks. Also, with Maya, accessing the coding language has 

made it possible to analyze the animation on an engineering application and level. The 

Maya models and animation changed the game by providing countless positions and 

versions of the models to submit for Solidworks testings, specifically for center of mass 

location movements and comparisons.  

The study of center of mass with Solidworks demonstrated that the change in 

position and the removal of a limb altered the location of the center of mass, no matter 

how minute these alterations may be. Symmetry and balance are such fragile elements 

within the human body that these seemingly minute changes can cause magnified 



80 
 

problems to the body over time, problems that may appear as posture, spine pain, and 

joint pain, etc. The gait analysis of the center of mass modifications demonstrated a 

potential relationship between center of mass location and base of support size. As the 

gait cycle steps were analyzed, the center of mass constantly moved showing the 

redistribution of weight and hip movements the body ensues during locomotion. As the 

base of support transformed with every step, so did the center of mass location as it 

shifted forward and back in the z direction. The comparison of natural human and 

amputee anatomies showed that the center of mass tended to shift towards the natural 

limb in an amputee, while fluctuating depending on stump length.  

An additional center of mass Solidworks analysis revealed that product choice 

impacted the location of the center of mass on the prosthesis. The ultimate goal of any 

prosthesis is for it to resemble the intended human function, such as a knee bend. When 

choosing a product, it is important to note if the material is lightweight and durable, 

because the comfort of the patient is most vital. Disregarding affordability, the primary 

goal should be to reestablish symmetry not only visually, but also physically by choosing 

products that present center of mass values that nearly mirror that of the patient’s natural 

leg. The study comparing the center of mass of the natural leg and the prosthesis material 

combinations showed that the natural leg ratio was COMNL = 0.6241, while the prosthesis 

combination ratio trials varied depending on material. Combination 3 produced the best 

COM y ratio results because the ratio was the closest to the knee joint bend and also was 

the closest in mirroring the natural leg COMNL value at 0.5972. The percent change of the 

combination 3 and natural leg comparison was 4.31%, thus deeming the asymmetry 
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insignificant. This solidified that combination 3 presented the best results in replicating 

the natural leg center of mass properties. 

The MatLab code had multiple functions and uses. Due to its autonomous design, 

it was easy to switch out data information and modify intended outputs. With the 

Solidworks center of mass calculations, the Matlab algorithms were able to establish an x 

and z axis percentage for the center of mass location at 47.49% of the patients 

measurements in the x direction and 36.72% of the z parameters of the patient. The 

extracted Maya MEL code provided data to run the created MatLab analysis codes for the 

torque and equilibrium testings. The MEL code extracted z direction joint angles that are 

rather small in magnitude because of the constraints the IK handles placed on the joint’s 

movements and rotations. This directly affected the equilibrium and torque output this 

input data created. When compared to the torque data produced by the given data from 

the previous study, the torque magnitudes in Table 15 proved to be close to that of the 

equilibrium values presented in Table 14. The MatLab code also showed the possible 

function of working with patient input data, such as gender, weight, and height, and 

inverse dynamics measurements method to establish the joint rotation of the patient in the 

z direction of movements.  

This thesis showed that testing equilibrium on a patient in dynamic movement 

may not be possible since the center of mass is constantly shifting and the base of support 

is constantly changing sizes, both balance contributors, during natural locomotion. The 

body’s form of balance in the dynamic phases requires the constant movement of the hips 

and weight shifts, and center of mass moves with the change of the body’s form. The 

center of mass alteration contributors were established as the stump length, prosthesis 
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weight, and body position and anatomy. Overall, this thesis approached the topics of 

center of mass, balance, and symmetry during gait in a novel method while utilizing 

software applications present in the visual arts, biomedical engineering, and mechanical 

engineering fields. The findings of this thesis show promise in positively impacting the 

present prosthesis fitting process by individualizing the methods with a newfound 

comprehension of the effects of center of mass, balance, and symmetry on the human 

body in different positions. 

 

  
Figure 57: Thesis summary flow chart diagram. 
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CHAPTER 6 – FUTURE WORK 

Maya Models and MEL code 

The default function for joints placement and movement is a method called FK or 

forward kinematics. Forward kinematics moves the joints depending on the created, 

default hierarchy. For the future, a further study on the joint rotation on the same walk 

cycle with the created rotation identification code will be used on FK joints instead of IK 

constraints. This analysis will determine if the z direction angles are truly affected by the 

IK handle constraints. An additional aspect of future studies will be to model and animate 

the female anatomy in Maya with the same constraints that were implemented on the 

male figure during the testings exhibited in this thesis. Furthermore, establishing the 

correct way to store values in a text file using MEL code will tremendously assist with 

the future goals of converting to an autonomous, simultaneous analysis of animated gait. 

Other Studies 

 The end goal will be to have a modified version of this system implemented in 

prosthetics and orthotics clinics to help in patient prosthesis fittings. To achieve this goal, 

the future path includes patient participation and clinical shadowing to gain more first-

hand experience and knowledge of the current fitting process. The analysis of the stump 

socket relationship from the patient information will prompt investigation of the stump 

pressure study during standing and walking. A pressure sensor study will prompt the 

creation of a pressure map system to collect stump socket relationship data. Future patient 

participation will assist in creating an autonomous system that is capable of gathering 

pressure information, gait, and center of mass to modify and/or add to the current 

prosthesis fitting method for the advanced ease and comfort of the patient. To assist in 
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creating a fully autonomous system, establishing a method to have Maya MEL code and 

MatLab communicate seamlessly regarding the joint rotations of the legs will further 

advance and ease the existing process. An additional idea I would like to incorporate 

during the developments of this research, is to see how my thesis can help or grown into 

the robotics realm of humanoids and rovers. 
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APPENDIX 

MEL code - Maya 

string $filePath = "C:/Users/kteti/Documents/animation/mel_code_1.txt" ; 

$fileId = `fopen $filePath "w"`; 

string $joints[]=`ls -type "joint"`; 

print($joints); 

string $hh; 

string $jn[]; 

matrix $m[9][7]; 

int $k = 0; 

int $j[] = {0,1,6,7,8,9,10};  

int $sc[] = {1,4,7,10,13,16,19,22,25}; 

float $fzz[]; 

int $size = size($sc); 

for($k=0;$k<size($j);++$k) { 

for($i=0;$i<$size;++$i) { 

$m[ $i ][ $k ]     = `getAttr -time $sc[ $i ] ($joints[ $j[ $k ] ]+ ".rotateZ")`; 

} 

$jn[ $k ] = $joints[ $j[ $k ] ]; 

fwrite $fileId ("\n"); 

fwrite $fileId ($jn[ $k ]); 

 

} 

$hh = print($m); 

$print($jn); 

fwrite $fileId ("\n"); 

fwrite $fileId ($hh); 

fclose $fileId ; 
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MatLab Code 

Center of mass percentages from (0,0,0) 

h=14.83; %centimeters(y) 

w=2.40; %centimeters(x) 

l=1.77; %centimeters(z) 

 

cmy=8.361; %centimeters(y) 

cmx=-0.029; %centimeters(x) 

cmz=-0.235; %centimeters(z) 

 

cmx1=(w/2)+cmx; 

cmz1=(l/2)+cmz; 

 

py=(cmy/h)*100; 

px=(cmx1/w)*100; 

pz=(cmz1/l)*100; 

 

fprintf('center of mass percentage for y ='); 

disp(py); 

fprintf('\ncenter of mass percentage for x ='); 

disp(px); 

fprintf('\ncenter of mass percentage for z ='); 

disp(pz); 

MatLab - with Maya output 

clear all; 

open MEL code data for z rotation 

data=xlsread('MEL_code_rot_data.xlsx'); 

ktime=data(:,1); 

ankle_L=data(:,2); 

ankle_R=data(:,3); 

hips=data(:,4); 

knee_L=data(:,5); 

knee_R=data(:,6); 

leg_L=data(:,7); 

leg_R=data(:,8); 

 

figure(); 

plot(ktime,ankle_L); 

hold on; 

plot(ktime,knee_L); 

hold on; 

plot(ktime,(leg_L).*-1); 

hold off; 

title('Left Leg Joint Movements, z-axis'); 

xlabel('keyframe time'); 

ylabel('degree of rotation'); 
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legend('ankle_L','knee_L','leg_L','Location','NorthWest'); 

 

figure(); 

plot(ktime,ankle_R); 

hold on; 

plot(ktime,knee_R); 

hold on; 

plot(ktime,(leg_R).*-1); 

hold off; 

title('Right Leg Joint Movements, z-axis'); 

xlabel('keyframe time'); 

ylabel('degree of rotation'); 

legend('ankle_R','knee_R','leg_R','Location','NorthWest'); 

 

figure(); 

plot(ktime,hips); 

title('Hip Rotation, along z-axis'); 

xlabel('keyframe time'); 

ylabel('degree of rotation'); 

 

EqA=[]; 

t=length(ktime); 

R=[ankle_R,knee_R,leg_R]; 

L=[ankle_L,knee_L,leg_L]; 

patient input TEST DATA 

W=175; % weight in pounds 

H=70; % height in inches, y-axis 

gender=1; %male=1 and female=0 

Torque - equations for left and right 

for i=1:t 

    theta1L=leg_L(i); % hip rotation data anterior-posterior, LEFT 

    theta2L=knee_L(i); % thigh rotation data anterior-posterior, LEFT 

    theta3L=ankle_L(i); %ankle rotation data, LEFT 

 

    theta1R=leg_R(i); % hip rotation data anterior-posterior, RIGHT 

    theta2R=knee_R(i); % thigh rotation data anterior-posterior, RIGHT 

    theta3R=ankle_R(i); %ankle rotation data, RIGHT 

 

if gender==1 

%male 

    fprintf("MALE\n"); 

%LEFT 

 

%HIP joint - point of rotation 

mlw=0.167*W; %total leg weight (thigh, ankle, shank) 

%theta1=115; %FULL range of motion MOVE TO PATIENT INPUT SECTION 

x=H*0.5925; %length of total leg 
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if abs(theta1L)==90 

    fTr1L=x*mlw; 

else 

    fTr1L=(x*sin(theta1L))*mlw; %posterior to anterior rotational torque 

end 

 

%KNEE joint - point of rotation 

tl=0.2320*H; %thigh length 

x1=x-tl; %total length of shank and foot 

%sl=0.2570*H; %shank length 

msw=0.0475*W; %shank weight 

mfw1=0.0143*W; %foot weight 

mkn=msw+mfw1; %total weight of the shank and foot 

 

if theta1L==0 && abs(theta2L)==90 %|| theta1>0 && theta2==90 

    fTr2L=x1*mkn; 

else 

    if theta1L>0 && theta1L==abs(theta2L) 

        fTr2L=(x1*tan(theta2L))*mkn; 

    else 

        if theta1L>0 && abs(theta2L)==90 

            nthetaL=theta1L-theta2L; 

            fTr2L=(x1*sin(nthetaL))*mkn; 

        else 

    fTr2L=(x1*sin(theta2L))*mkn; 

        end 

    end 

end 

 

%ANKLE joint - point of rotation 

fl=0.1484*H; %foot length (the area touching the floor, pad of foot) 

mfw2=0.0143*W; %foot weight 

 

if theta1L==0 && theta2L==0 && theta3L==0 || theta1L==90 && theta2L==90 && theta3L==0 || 

theta1L<0 && abs(theta1L)==abs(theta2L) && theta3L==0 

    fTr3L=fl*mfw2; 

else 

    fTr3L=(fl*sin(theta3L))*mfw2; 

end 

 

%RIGHT 

 

%HIP joint - point of rotation 

mlw=0.167*W; %total leg weight (thigh, ankle, shank) 

%theta1=115; %FULL range of motion MOVE TO PATIENT INPUT SECTION 

x=H*0.5925; %length of total leg 

 

if abs(theta1R)==90 

    fTr1R=x*mlw; 

else 

    fTr1R=(x*sin(theta1R))*mlw; %posterior to anterior rotational torque 

end 

 

%KNEE joint - point of rotation 
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tl=0.2320*H; %thigh length 

x1=x-tl; %total length of shank and foot 

%sl=0.2570*H; %shank length 

msw=0.0475*W; %shank weight 

mfw1=0.0143*W; %foot weight 

mkn=msw+mfw1; %total weight of the shank and foot 

 

if theta1R==0 && abs(theta2R)==90 %|| theta1>0 && theta2==90 

    fTr2R=x1*mkn; 

else 

    if theta1R>0 && theta1R==abs(theta2R) 

        fTr2R=(x1*tan(theta2R))*mkn; 

    else 

        if theta1R>0 && abs(theta2R)==90 

            nthetaR=theta1R-theta2R; 

            fTr2R=(x1*sin(nthetaR))*mkn; 

        else 

    fTr2R=(x1*sin(theta2R))*mkn; 

        end 

    end 

end 

 

%ANKLE joint - point of rotation 

fl=0.1484*H; %foot length (the area touching the floor, pad of foot) 

mfw2=0.0143*W; %foot weight 

 

if theta1R==0 && theta2R==0 && theta3R==0 || theta1R==90 && theta2R==90 && theta3R==0 || 

theta1R<0 && abs(theta1R)==abs(theta2R) && theta3R==0 

    fTr3R=fl*mfw2; 

else 

    fTr3R=(fl*sin(theta3R))*mfw2; 

end 

 

else 

 

%female 

    fprintf("FEMALE\n"); 

%LEFT 

 

%HIP joint - point of rotation 

flw=0.184*W; %total leg weight (thigh, ankle, shank) 

%theta1=115; %FULL range of motion MOVE TO PATIENT INPUT SECTION 

x=H*0.5925; %length of total leg 

 

if abs(theta1L)==90 

    fTr1L=x*flw; 

else 

    fTr1L=(x*sin(theta1L))*flw; %posterior to anterior rotational torque 

end 

 

%KNEE joint - point of rotation 

tl=0.2320*H; %thigh length 

x1=x-tl; %total length of shank and foot 

%sl=0.2570*H; %shank length 
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fsw=0.0535*W; %shank weight 

ffw1=0.0133*W; %foot weight 

fkn=fsw+ffw1; %total weight of the shank and foot 

 

if theta1L==0 && abs(theta2L)==90 %|| theta1>0 && theta2==90 

    fTr2L=x1*fkn; 

else 

    if theta1L>0 && theta1L==abs(theta2L) 

        fTr2L=(x1*tan(theta2L))*fkn; 

    else 

        if theta1L>0 && abs(theta2L)==90 

            nthetaL=theta1L-theta2L; 

            fTr2L=(x1*sin(nthetaL))*fkn; 

        else 

    fTr2L=(x1*sin(theta2L))*fkn; 

        end 

    end 

end 

 

%ANKLE joint - point of rotation 

fl=0.1484*H; %foot length (the area touching the floor, pad of foot) 

ffw2=0.0133*W; %foot weight 

 

if theta1L==0 && theta2L==0 && theta3L==0 || theta1L==90 && theta2L==90 && theta3L==0 || 

theta1L<0 && abs(theta1L)==abs(theta2L) && theta3L==0 

    fTr3L=fl*ffw2; 

else 

    fTr3L=(fl*sin(theta3L))*ffw2; 

end 

 

%RIGHT 

 

%HIP joint - point of rotation 

flw=0.184*W; %total leg weight (thigh, ankle, shank) 

%theta1=115; %FULL range of motion MOVE TO PATIENT INPUT SECTION 

x=H*0.5925; %length of total leg 

 

if abs(theta1R)==90 

    fTr1R=x*flw; 

else 

    fTr1R=(x*sin(theta1R))*flw; %posterior to anterior rotational torque 

end 

 

%KNEE joint - point of rotation 

tl=0.2320*H; %thigh length 

x1=x-tl; %total length of shank and foot 

%sl=0.2570*H; %shank length 

fsw=0.0535*W; %shank weight 

ffw1=0.0133*W; %foot weight 

fkn=fsw+ffw1; %total weight of the shank and foot 

 

if theta1R==0 && abs(theta2R)==90 %|| theta1>0 && theta2==90 

    fTr2R=x1*fkn; 

else 
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    if theta1R>0 && theta1R==abs(theta2R) 

        fTr2R=(x1*tan(theta2R))*fkn; 

    else 

        if theta1R>0 && abs(theta2R)==90 

            nthetaR=theta1R-theta2R; 

            fTr2R=(x1*sin(nthetaR))*fkn; 

        else 

    fTr2R=(x1*sin(theta2R))*fkn; 

        end 

    end 

end 

 

%ANKLE joint - point of rotation 

fl=0.1484*H; %foot length (the area touching the floor, pad of foot) 

ffw2=0.0133*W; %foot weight 

 

if theta1R==0 && theta2R==0 && theta3R==0 || theta1R==90 && theta2R==90 && theta3R==0 || 

theta1R<0 && abs(theta1R)==abs(theta2R) && theta3R==0 

    fTr3R=fl*ffw2; 

else 

    fTr3R=(fl*sin(theta3R))*ffw2; 

end 

end 

 

% Equilibrium - torques equal to each other 

EqL=fTr1L+fTr2L+fTr3L; 

EqR=fTr1R+fTr2R+fTr3R; 

 

if EqL==EqR 

    fprintf("stable\n"); 

else 

    EqN=EqL-EqR; 

    fprintf("unstable\n"); 

    if EqN>0 

        fprintf("left leg\n"); 

        fprintf("torque difference ="); 

        disp(EqN); 

    else 

        fprintf("right leg\n"); 

        fprintf("torque difference ="); 

        disp(EqN); 

    end 

end 

EqA(i)=EqN; 

i=i+1; 

end 

MatLab code - given input data 

clear all; 
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open data for joint rotation 

data=xlsread('Given data_joint angles.xlsx'); 

ktime=data(:,1); 

ankle=data(:,4); 

knee=data(:,3); 

leg=data(:,2); 

 

EqA=[]; 

t=length(ktime); 

patient input TEST DATA 

W=175; % weight in pounds 

H=70; % height in inches, y-axis 

gender=1; %male=1 and female=0 

Torque - equations for left and right 

for i=1:t 

    theta1L=leg(i); % hip rotation data anterior-posterior, LEFT 

    theta2L=knee(i); % thigh rotation data anterior-posterior, LEFT 

    theta3L=ankle(i); %ankle rotation data, LEFT 

 

 

if gender==1 

%male 

    fprintf("MALE\n"); 

%LEFT 

 

%HIP joint - point of rotation 

mlw=0.167*W; %total leg weight (thigh, ankle, shank) 

%theta1=115; %FULL range of motion MOVE TO PATIENT INPUT SECTION 

x=H*0.5925; %length of total leg 

 

if abs(theta1L)==90 

    fTr1L=x*mlw; 

else 

    fTr1L=(x*sin(theta1L))*mlw; %posterior to anterior rotational torque 

end 

 

%KNEE joint - point of rotation 

tl=0.2320*H; %thigh length 

x1=x-tl; %total length of shank and foot 

%sl=0.2570*H; %shank length 

msw=0.0475*W; %shank weight 

mfw1=0.0143*W; %foot weight 

mkn=msw+mfw1; %total weight of the shank and foot 

 

if theta1L==0 && abs(theta2L)==90 %|| theta1>0 && theta2==90 

    fTr2L=x1*mkn; 
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else 

    if theta1L>0 && theta1L==abs(theta2L) 

        fTr2L=(x1*tan(theta2L))*mkn; 

    else 

        if theta1L>0 && abs(theta2L)==90 

            nthetaL=theta1L-theta2L; 

            fTr2L=(x1*sin(nthetaL))*mkn; 

        else 

    fTr2L=(x1*sin(theta2L))*mkn; 

        end 

    end 

end 

 

%ANKLE joint - point of rotation 

fl=0.1484*H; %foot length (the area touching the floor, pad of foot) 

mfw2=0.0143*W; %foot weight 

 

if theta1L==0 && theta2L==0 && theta3L==0 || theta1L==90 && theta2L==90 && theta3L==0 || 

theta1L<0 && abs(theta1L)==abs(theta2L) && theta3L==0 

    fTr3L=fl*mfw2; 

else 

    fTr3L=(fl*sin(theta3L))*mfw2; 

end 

 

else 

%female 

    fprintf("FEMALE\n"); 

%LEFT 

 

%HIP joint - point of rotation 

flw=0.184*W; %total leg weight (thigh, ankle, shank) 

%theta1=115; %FULL range of motion MOVE TO PATIENT INPUT SECTION 

x=H*0.5925; %length of total leg 

 

if abs(theta1L)==90 

    fTr1L=x*flw; 

else 

    fTr1L=(x*sin(theta1L))*flw; %posterior to anterior rotational torque 

end 

 

%KNEE joint - point of rotation 

tl=0.2320*H; %thigh length 

x1=x-tl; %total length of shank and foot 

%sl=0.2570*H; %shank length 

fsw=0.0535*W; %shank weight 

ffw1=0.0133*W; %foot weight 

fkn=fsw+ffw1; %total weight of the shank and foot 

 

if theta1L==0 && abs(theta2L)==90 %|| theta1>0 && theta2==90 

    fTr2L=x1*fkn; 

else 

    if theta1L>0 && theta1L==abs(theta2L) 

        fTr2L=(x1*tan(theta2L))*fkn; 

    else 
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        if theta1L>0 && abs(theta2L)==90 

            nthetaL=theta1L-theta2L; 

            fTr2L=(x1*sin(nthetaL))*fkn; 

        else 

    fTr2L=(x1*sin(theta2L))*fkn; 

        end 

    end 

end 

 

%ANKLE joint - point of rotation 

fl=0.1484*H; %foot length (the area touching the floor, pad of foot) 

ffw2=0.0133*W; %foot weight 

 

if theta1L==0 && theta2L==0 && theta3L==0 || theta1L==90 && theta2L==90 && theta3L==0 || 

theta1L<0 && abs(theta1L)==abs(theta2L) && theta3L==0 

    fTr3L=fl*ffw2; 

else 

    fTr3L=(fl*sin(theta3L))*ffw2; 

end 

 

end 

 

% Equilibrium - torques equal to each other 

fprintf("hip torque ="); 

disp(fTr1L); 

fprintf("knee torque ="); 

disp(fTr2L); 

fprintf("ankle torque ="); 

disp(fTr3L); 

 

end 

MatLab - code with patient input 

clear all; 

patient input TEST DATA 

W=175; % weight in pounds 

H=70; % height in inches, y-axis 

gender=0; %male=1 and female=0 

angle rotations along z-axis - patient input based on leg position, LEFT 

theta1L=70; % hip rotation data anterior-posterior 

theta2L=-10.006; % thigh rotation data anterior-posterior 

theta3L=1.5; %ankle rotation data 
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angle rotations along z-axis - patient input based on leg position, RIGHT 

theta1R=0; % hip rotation data anterior-posterior 

theta2R=0; % thigh rotation data anterior-posterior 

theta3R=0; %ankle rotation data 

Torque - equations for left and right 

if gender==1 

%male 

    fprintf("MALE\n"); 

%LEFT 

 

%HIP joint - point of rotation 

mlw=0.167*W; %total leg weight (thigh, ankle, shank) 

%theta1=115; %FULL range of motion MOVE TO PATIENT INPUT SECTION 

x=H*0.5925; %length of total leg 

 

if abs(theta1L)==90 

    fTr1L=x*mlw; 

else 

    fTr1L=(x*sin(theta1L))*mlw; %posterior to anterior rotational torque 

end 

 

%KNEE joint - point of rotation 

tl=0.2320*H; %thigh length 

x1=x-tl; %total length of shank and foot 

%sl=0.2570*H; %shank length 

msw=0.0475*W; %shank weight 

mfw1=0.0143*W; %foot weight 

mkn=msw+mfw1; %total weight of the shank and foot 

 

if theta1L==0 && abs(theta2L)==90 %|| theta1>0 && theta2==90 

    fTr2L=x1*mkn; 

else 

    if theta1L>0 && theta1L==abs(theta2L) 

        fTr2L=(x1*tan(theta2L))*mkn; 

    else 

        if theta1L>0 && abs(theta2L)==90 

            nthetaL=theta1L-theta2L; 

            fTr2L=(x1*sin(nthetaL))*mkn; 

        else 

    fTr2L=(x1*sin(theta2L))*mkn; 

        end 

    end 

end 

 

%ANKLE joint - point of rotation 

fl=0.1484*H; %foot length (the area touching the floor, pad of foot) 

mfw2=0.0143*W; %foot weight 

 

if theta1L==0 && theta2L==0 && theta3L==0 || theta1L==90 && theta2L==90 && theta3L==0 || 
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theta1L<0 && abs(theta1L)==abs(theta2L) && theta3L==0 

    fTr3L=fl*mfw2; 

else 

    fTr3L=(fl*sin(theta3L))*mfw2; 

end 

 

%RIGHT 

 

%HIP joint - point of rotation 

mlw=0.167*W; %total leg weight (thigh, ankle, shank) 

%theta1=115; %FULL range of motion MOVE TO PATIENT INPUT SECTION 

x=H*0.5925; %length of total leg 

 

if abs(theta1R)==90 

    fTr1R=x*mlw; 

else 

    fTr1R=(x*sin(theta1R))*mlw; %posterior to anterior rotational torque 

end 

 

%KNEE joint - point of rotation 

tl=0.2320*H; %thigh length 

x1=x-tl; %total length of shank and foot 

%sl=0.2570*H; %shank length 

msw=0.0475*W; %shank weight 

mfw1=0.0143*W; %foot weight 

mkn=msw+mfw1; %total weight of the shank and foot 

 

if theta1R==0 && abs(theta2R)==90 %|| theta1>0 && theta2==90 

    fTr2R=x1*mkn; 

else 

    if theta1R>0 && theta1R==abs(theta2R) 

        fTr2R=(x1*tan(theta2R))*mkn; 

    else 

        if theta1R>0 && abs(theta2R)==90 

            nthetaR=theta1R-theta2R; 

            fTr2R=(x1*sin(nthetaR))*mkn; 

        else 

    fTr2R=(x1*sin(theta2R))*mkn; 

        end 

    end 

end 

 

%ANKLE joint - point of rotation 

fl=0.1484*H; %foot length (the area touching the floor, pad of foot) 

mfw2=0.0143*W; %foot weight 

 

if theta1R==0 && theta2R==0 && theta3R==0 || theta1R==90 && theta2R==90 && theta3R==0 || 

theta1R<0 && abs(theta1R)==abs(theta2R) && theta3R==0 

    fTr3R=fl*mfw2; 

else 

    fTr3R=(fl*sin(theta3R))*mfw2; 

end 

 

else 



101 
 

 

%female 

    fprintf("FEMALE\n"); 

%LEFT 

 

%HIP joint - point of rotation 

flw=0.184*W; %total leg weight (thigh, ankle, shank) 

%theta1=115; %FULL range of motion MOVE TO PATIENT INPUT SECTION 

x=H*0.5925; %length of total leg 

 

if abs(theta1L)==90 

    fTr1L=x*flw; 

else 

    fTr1L=(x*sin(theta1L))*flw; %posterior to anterior rotational torque 

end 

 

%KNEE joint - point of rotation 

tl=0.2320*H; %thigh length 

x1=x-tl; %total length of shank and foot 

%sl=0.2570*H; %shank length 

fsw=0.0535*W; %shank weight 

ffw1=0.0133*W; %foot weight 

fkn=fsw+ffw1; %total weight of the shank and foot 

 

if theta1L==0 && abs(theta2L)==90 %|| theta1>0 && theta2==90 

    fTr2L=x1*fkn; 

else 

    if theta1L>0 && theta1L==abs(theta2L) 

        fTr2L=(x1*tan(theta2L))*fkn; 

    else 

        if theta1L>0 && abs(theta2L)==90 

            nthetaL=theta1L-theta2L; 

            fTr2L=(x1*sin(nthetaL))*fkn; 

        else 

    fTr2L=(x1*sin(theta2L))*fkn; 

        end 

    end 

end 

 

%ANKLE joint - point of rotation 

fl=0.1484*H; %foot length (the area touching the floor, pad of foot) 

ffw2=0.0133*W; %foot weight 

 

if theta1L==0 && theta2L==0 && theta3L==0 || theta1L==90 && theta2L==90 && theta3L==0 || 

theta1L<0 && abs(theta1L)==abs(theta2L) && theta3L==0 

    fTr3L=fl*ffw2; 

else 

    fTr3L=(fl*sin(theta3L))*ffw2; 

end 

 

%RIGHT 

 

%HIP joint - point of rotation 

flw=0.184*W; %total leg weight (thigh, ankle, shank) 
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%theta1=115; %FULL range of motion MOVE TO PATIENT INPUT SECTION 

x=H*0.5925; %length of total leg 

 

if abs(theta1R)==90 

    fTr1R=x*flw; 

else 

    fTr1R=(x*sin(theta1R))*flw; %posterior to anterior rotational torque 

end 

 

%KNEE joint - point of rotation 

tl=0.2320*H; %thigh length 

x1=x-tl; %total length of shank and foot 

%sl=0.2570*H; %shank length 

fsw=0.0535*W; %shank weight 

ffw1=0.0133*W; %foot weight 

fkn=fsw+ffw1; %total weight of the shank and foot 

 

if theta1R==0 && abs(theta2R)==90 %|| theta1>0 && theta2==90 

    fTr2R=x1*fkn; 

else 

    if theta1R>0 && theta1R==abs(theta2R) 

        fTr2R=(x1*tan(theta2R))*fkn; 

    else 

        if theta1R>0 && abs(theta2R)==90 

            nthetaR=theta1R-theta2R; 

            fTr2R=(x1*sin(nthetaR))*fkn; 

        else 

    fTr2R=(x1*sin(theta2R))*fkn; 

        end 

    end 

end 

 

%ANKLE joint - point of rotation 

fl=0.1484*H; %foot length (the area touching the floor, pad of foot) 

ffw2=0.0133*W; %foot weight 

 

if theta1R==0 && theta2R==0 && theta3R==0 || theta1R==90 && theta2R==90 && theta3R==0 || 

theta1R<0 && abs(theta1R)==abs(theta2R) && theta3R==0 

    fTr3R=fl*ffw2; 

else 

    fTr3R=(fl*sin(theta3R))*ffw2; 

end 

end 

Equilibrium - torques equal to each other 

% left side 

EqL=fTr1L+fTr2L+fTr3L; 

EqR=fTr1R+fTr2R+fTr3R; 

 

if EqL==EqR 

    fprintf("stable\n"); 

else 
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    EqN=EqL-EqR; 

    fprintf("unstable\n"); 

    if EqN>0 

        fprintf("left leg\n"); 

        fprintf("torque difference ="); 

        disp(EqN); 

    else 

        fprintf("right leg\n"); 

        fprintf("torque difference ="); 

        disp(EqN); 

    end 

end 

Published with MATLAB® R2019b 

 

 

https://www.mathworks.com/products/matlab

	A Comprehensive Analysis of Balance, Symmetry, and Center of Mass in the Gait Cycle of Transfemoral Amputees
	Recommended Citation

	Center of mass percentages from (0,0,0)
	MatLab - with Maya output
	open MEL code data for z rotation
	patient input TEST DATA
	Torque - equations for left and right
	MatLab code - given input data
	open data for joint rotation
	patient input TEST DATA
	Torque - equations for left and right
	MatLab - code with patient input
	patient input TEST DATA
	angle rotations along z-axis - patient input based on leg position, LEFT
	angle rotations along z-axis - patient input based on leg position, RIGHT
	Torque - equations for left and right
	Equilibrium - torques equal to each other

